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PrecisionID Code 128 Barcode Font User Manual 
 
Notice: When you use this product you agree to the End User License Agreement (EULA). The EULA is 
provided as a file in the package for this product. To view the license online, please visit 
http://www.precisionid.com/licenses/ 
 
Limitations of the demo version: The demo version of this product may be used for evaluation purposes 
only. In the demo version, the number 7 and the characters G, S and X contain the demo watermark. All 
other characters and symbols are exactly the same as the purchased version.  If you are using the demo 
version and you would like to order, please visit: http://www.precisionid.com/ 
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Code 128 Barcode Symbology Overview 
Code 128 Barcodes are also referred to as UCC-128, EAN-128 or UCC/EAN 128. Code 128 Barcodes 
can encode uppercase and lowercase letters, numbers, special characters and functions such as tabs and 
returns. Code128 Barcodes require that a MOD 103 check digit be included in the barcode before the stop 
digit for the scanner to read it. All barcodes require start and stop characters.  
 



 2

PrecisionID Code 128 Barcode Font Product Overview 
Code 128 Barcodes are more complex most other linear barcodes because they require a check digit and 
contain 3 character sets with special switch functions. PrecisionID Font Formatting Components ™ are 
provided with this package to simplify this process and make printing code 128 barcodes with our fonts 
an easy task. The PrecisionID Font Formatting Components ™ include a Crystal Reports UFL, Microsoft 
VBA module for Excel and Access and Visual Basic source code, which may also be used as a guide for 
conversion to other languages. This package also provides working examples for Word, Access, Excel 
and Crystal Reports. 
 

Installation 
Microsoft Windows 
Decompress the barcode fonts in the supplied ZIP file with a decompression utility, such as Winzip. 
PrecisionID Barcode fonts are compatible with all 32-bit versions of Windows. PrecisionID recommends 
using the supplied Setup.exe file to install the fonts automatically in Windows. If you wish to manually 
install the fonts in Windows, open the Control Panel and choose Fonts; then choose Install New Font and 
browse to the folder that contains the code 128 bar code fonts with the TTF extension extracted from the 
zip file. 
 
Macintosh OS X 
PrecisionID fonts are compatible with all versions of Macintosh OS Version 10.1 and greater (OSX). 
Decompress the barcode fonts in the supplied ZIP file with a decompression utility such as Stuffit 
Expander. Drag the barcode font files with the TTF extension to the Library/Fonts folder of your hard 
drive. To activate the fonts, restart the application; some applications may require a restart of the 
computer.  
 
Other Operating Systems 
We supply Windows TrueType (TTF) fonts as well as Binary (PFB) and ASCII (PFA) versions of 
PostScript fonts. Consult the documentation for your operating system about instructions and which 
barcode font to install. 
 

Using PrecisionID Code 128 Barcode Fonts to Create Barcodes 
When creating barcodes with PrecisionID fonts, we recommend using the PrecisionID Font Formatting 
Components ™. These functions automatically format the data and calculate and add the required Start, 
Stop and MOD 103 check characters. The returned text when displayed or printed in the PrecisionID 
Code 128 Barcode Font is a valid, scannable barcode. 
 
To calculate the check digit manually, we suggest following the Visual Basic source code we provide. 
This code is located in the Examples\VB Module folder of the package. 
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Microsoft Office 2010 and Office 2007 Examples 
The results for the following tutorials are saved in the examples folder of the product zip file or the 
product installation directory. Refer to the examples provided in this folder for quick and accurate 
implementation of your PrecisionID barcode. 
 
Microsoft Excel 2010 and Excel 2007 

1. NOTE: the PrecisionID C128 T04 font is formatted specifically for use in Microsoft Excel. Other 
fonts may work but may not format properly in the cells. 

2. In this example we will create a barcode in cell B8 using the data from cell A8 for the barcode. 
3. Extract the PrecisionID_C128_Module.bas file from the package and place it in a folder of your 

choice. 
4. Before creating Code 128 barcodes in Excel 2010 or 2007, you must enable the Developer Menu 

to import the required module so it will run. If you already see the Developers Tab, you may skip 
to Step 10 

5. [Excel 2010] Select the File Tab and then Options from list in the left column. 
6. [Excel 2010] In the Excel Options window select Customize Ribbon 
7. [Excel 2010] In the right half of the window, check the “Developer” check box and click OK. 
8. [Excel 2007] Click the Office Button and select Excel Options at the bottom.   

 
9. [Excel 2007] In the Popular Options check the “Show Developer Tab in the Ribbon”.  Click OK. 

 
10. Select the Developer Tab and click the Visual Basic Icon. 
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11. Choose File – Import File and navigate to the PrecisionID_C128_Module.bas file located in the 
Program Files\PrecisionID Code 128 Font Package folder.  After this module is imported, it will 
be visible in the list of modules. Choose File – Close and return to Excel. 

 
12. In cell B8, enter the formula =PrecisionID_C128AUTO(A8) which is required to format the data 

to the font. 

 
13. Notice that the formula changed the data from cell A8 and appended additional characters at the 

beginning and ending of the text. Also notice that numbers from the data are compressed into 
other characters; this is normal when using Code 128 Auto and the barcode contains 4 or more 
consecutive number characters. 

 
14. With cell B8 selected, choose the PrecisionID C128 T04 font, which is specifically formatted for 

use in Microsoft Excel, and choose 12 for the point size. PrecisionID also recommends centering 
the text in this cell so the barcode will contain white space before and after the barcode. It is 
required to select the appropriate barcode font for the formula being used. For example, a code 
128 barcode formula requires a Code 128 barcode font. 

 
15. After selecting the bar code font, the barcode will appear. Size the width of the column so that 

there is some white space before and after the bars of the barcode. 

 
16. To create an entire column of barcodes, choose Edit – Copy with cell B8 selected. 
17. Highlight cells you wish to add barcodes to in column B and choose Edit - Paste. The formula will 

automatically adjust for the other cells. 
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Microsoft Word 2010 and Word 2007 Mail-Merge 
1. Open the mail merge document. 
2. To create a barcode in a Word 2010 or 2007 mail-merge, we must insert a merge field from a data 

source that has already formatted the text for the barcode font. In this example, we use Excel as 
the data source. The Excel spreadsheet data source must already be setup with barcodes just like 
the Excel Tutorial in this document. 

3. In Word 2007, select the Mailings menu item, click Start Mail Merge and select the type of 
document to create.                                                                                

 
4. Click Select Recipients and select Use Existing List.  Navigate to the spreadsheet with the barcode 

data.  Finally select the Worksheet within the Workbook with the data, i.e. “sheet1”. 

 
5. Place the cursor at the location for the barcode and click Insert Merge Field and select the 

information to be inserted; i.e. “FormattedText”. 

 
6. If you click “Preview Results”, the text formatted for the barcode from the data source appears. 

 

 
7. Select the text in the merged data and choose the PrecisionID C128 08 font. Make the font 12 

points in size. 

 
8. For additional help, see Word 2007 Help or use the Mail Merge Wizard under Mailings - Start 

Mail Merge. 
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Microsoft Access 2010 and Access 2007 
To create a code 128 barcode in a Microsoft Access report: 

1. Run the Setup program to install the barcode fonts, VB Module, and Access Example file. 
2. Create a new blank database.  [Access 2010] Select the File tab and double click New Database or 

[Access 2007] Click the Office Button, select New, name the file, and click Create.  
3. Enter some data into a new field.  This data will be encoded into a barcode.     

 
4. Save the database. 
5. Before creating barcodes in Microsoft Access, you must import the required module. Select 

Database Tools and click the Visual Basic button.  

 
6. Select File – Import File…   and navigate to the PrecisionID_C128_Module.bas, which is located 

in the Program Files\PrecisionID Code 128 Font Package folder. After it is properly imported, it 
will appear as one of the modules in the database. 

 
7. Save the module with the database by selecting File – Save.                                 

 
8. Select File – Close to return to Microsoft Access 2010 / 2007. 
9. Create a report by selecting Create – Report in the Ribbon.  
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10. Go to Design Mode by Right Clicking the Reports Tab and selecting Design View. 

 
11. Add a Textbox to the report. This text box will be modified to contain a barcode.  
12. Select the textbox and if the properties window is not visible, Right click on the text box and 

choose properties. 
13. Place the formula =PrecisionID_C128AUTO([Field1]) for Access 2010 or 

=PrecisionID_C128AUTO([Table1.Field1]) for Access 2007 in the control source property of the 
text box where Table1 is the table and Field1 is the field that contains the data to be encoded into 
the code 128 barcode.  The PrecisionID formulas for code sets A, B, or C may be used instead if 
the barcode needs to be limited to one code set.  See code set information later in this manual. 

 
14. Change back to Report View by right clicking the report’s tab and selecting Report View. You 

should see that the formula changed the data from the database and appended additional characters 
at the beginning and ending of the text. You may notice that the numbers from the data are 
compressed into other characters; this is normal when using Code 128 Auto and the barcode 
contains 4 or more consecutive number characters. 

 
15. Switch back to the report in Design View, select the text box and choose one of the PrecisionID 

fonts such as PrecisionID C128 T08 and choose 12 for the point size of the font. You must select 
the appropriate font for the formula you are using. For example, if you have a formula for a Code 
128 barcode, you must select a Code 128 Font. 

16. Size the text box so it is large enough to contain the entire barcode. You will need to adjust both 
the height and width. Be sure to leave some extra space to the right and left of the barcode in the 
report. Generally, the space should be about 3 times wider than the thickest bar in the code 128 
barcode. 
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17. Switch back to Report View and the Code 128 Barcode will appear in the text box. 
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Information for Specific Implementations 
 
Creating Check Digits in Other Applications 
The easiest method of creating source code for a check digit in a custom application is to use our 
PrecisionID_C128_Module.bas module as a guide. The module was written to be compatible with Visual 
Basic 6 and Microsoft Office VBA and may be viewed with a text editor. This module is located in the 
Examples\VB Module folder of the package. 
 
Printing Text Below the Barcode 
Human-readable or text fonts are not provided in this package because they do not work well with Code 
128. If you need to place text below the barcode, we suggest simply printing the data you are encoding in 
a text font below the barcode on your report. 
 
UCC/EAN-128 Barcodes 
Our PrecisionID Font Formatting Components™ allow the creation of UCC128 and EAN128 barcodes by 
simply substituting the ASCII 202 character for the FNC1 when in C128AUTO.  For example, to create 
the UCC/EAN barcode of (8100) 712345 (21) 12345678 the text of Ê8100654321Ê2187654321 would 
need to be sent to the C128AUTO function where Ê is the ASCII 202 character or Chr(202) in VB. The 
text portion for this barcode type must be created as a separate field below the barcode using a text font.  
 
The Excel example has a very good example of creating EAN-128 barcodes. 
 
USPS EAN128 Barcodes 
The PrecisionID C128 14 font when printed at 16 points creates the required bar code size for USPS 
EAN128 barcodes. The text at the bottom of the barcode must be formatted properly and printed with the 
PrecisionID OCR-A font to meet the USPS specification. 
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Specifications 
Font Point Sizes and X Dimension (Narrow Bar Width) 
Our fonts are designed to print with precision on high resolution printers as well as low resolution printers 
such as 203 dpi thermal barcode printers. When printing at 203 dpi, the point size chosen should be a 
multiple of 6. When printing at 300 dpi, the point size chosen should be a multiple of 4. 
 
Font point size X Dimension (narrow bar width) 

measured in mils (1/1000 of an inch) 
6 5 
8 7 
12 (recommended) 10 
16 13 
20 16 
24 20 
36 30 
 
Font Names and Bar Code Height 
The numbers at the end of the font name are to identify the height of the font in millimeters (mm) when 
printed at 12 points.  
 
Font Name Approximate Font Height at 12 points 
PrecisionID C128 04 .18” or 04mm (use in Excel) 
PrecisionID C128 08 .30” or 08mm 
PrecisionID C128 12 .45” or 12mm 
PrecisionID C128 14 .56” or 14mm (used for USPS and EAN 128) 
PrecisionID C128 18 .70” or 18mm 
PrecisionID C128 22 .90” or 22mm 
 

Code 128 Character Sets A, B, and C 
The PrecisionID_C128Auto(data) function automatically switches between character sets to create the 
most compact barcode possible for the data.  Most of the time the barcode will start with character set B 
as it has the broadest and most common variety of characters.  When several consecutive numbers appear 
in the data, the function will switch to character set C and if a control character is encountered (such as a 
TAB or CR), the function will switch to character set A. 
 
Some implementations of Code 128 may require the barcode be limited to a specific character set.  If this 
is required, additional functions are provided that do not auto-switch.  See The Code 128 Character Chart 
for the specific characters available within each character set. 
 Character Set A PrecisionID_C128_A(data) 
 Character Set B PrecisionID_C128_B(data) 
 Character Set C PrecisionID_C128_C(data) 
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The Code 128 Character Chart 
The fonts were created according to the chart below. If you have an advanced knowledge of the Code 128 
specifications, you can use this chart to manually create your barcodes and calculate the check digit. 
 
Value Set_A Set_B Set_C ASCII Text  Value Set_A Set_B Set_C ASCII Text
0 Space Space 0 194 Â  54 V V 54 86 V 
1 ! ! 1 33 !  55 W W 55 87 W 
2 " " 2 34 "  56 X X 56 88 X 
3 # # 3 35 #  57 Y Y 57 89 Y 
4 $ $ 4 36 $  58 Z Z 58 90 Z 
5 % % 5 37 %  59 [ [ 59 91 [ 
6 & & 6 38 &  60 \ \ 60 92 \ 
7 ' ' 7 39 '  61 ] ] 61 93 ] 
8 ( ( 8 40 (  62 ^ ^ 62 94 ^ 
9 ) ) 9 41 )  63 _ _ 63 95 _ 
10 * * 10 42 *  64 nul ` 64 96 ` 
11 + + 11 43 +  65 soh a 65 97 a 
12 , , 12 44 ,  66 stx b 66 98 b 
13 - - 13 45 -  67 etx c 67 99 c 
14 . . 14 46 .  68 eot d 68 100 d 
15 / / 15 47 /  69 eno e 69 101 e 
16 0 0 16 48 0  70 ack f 70 102 f 
17 1 1 17 49 1  71 bel g 71 103 g 
18 2 2 18 50 2  72 bs h 72 104 h 
19 3 3 19 51 3  73 ht i 73 105 i 
20 4 4 20 52 4  74 lf j 74 106 j 
21 5 5 21 53 5  75 vt k 75 107 k 
22 6 6 22 54 6  76 ff l 76 108 l 
23 7 7 23 55 7  77 cr m 77 109 m 
24 8 8 24 56 8  78 s0 n 78 110 n 
25 9 9 25 57 9  79 s1 o 79 111 o 
26 : : 26 58 :  80 dle p 80 112 p 
27 ; ; 27 59 ;  81 dc1 q 81 113 q 
28 < < 28 60 <  82 dc2 r 82 114 r 
29 = = 29 61 =  83 dc3 s 83 115 s 
30 > > 30 62 >  84 dc4 t 84 116 t 
31 ? ? 31 63 ?  85 nak u 85 117 u 
32 @ @ 32 64 @  86 syn v 86 118 v 
33 A A 33 65 A  87 etb w 87 119 w 
34 B B 34 66 B  88 can x 88 120 x 
35 C C 35 67 C  89 em y 89 121 y 
36 D D 36 68 D  90 sub z 90 122 z 
37 E E 37 69 E  91 esc { 91 123 { 
38 F F 38 70 F  92 fs | 92 124 | 
39 G G 39 71 G  93 gs } 93 125 } 
40 H H 40 72 H  94 rs ~ 94 126 ~ 
41 I I 41 73 I  95 us del 95 195 Ã 
42 J J 42 74 J  96 Fn 3 Fn 3 96 196 Ä 
43 K K 43 75 K  97 Fn 2 Fn 2 97 197 Å 
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44 L L 44 76 L  98 Shift Shift 98 198 Æ 
45 M M 45 77 M  99 code C code C 99 199 Ç 
46 N N 46 78 N  100 code B Fn 4 code B 200 È 
47 O O 47 79 O  101 Fn 4 code A code A 201 É 
48 P P 48 80 P  102 Fn 1 Fn 1 Fn 1 202 Ê 
49 Q Q 49 81 Q  103 Start A Start A Start A 203 Ë 
50 R R 50 82 R  104 Start B Start B Start B 204 Ì 
51 S S 51 83 S  105 Start C Start C Start C 205 Í 
52 T T 52 84 T    Stop Stop Stop 206 Î 
53 U U 53 85 U              
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PrecisionID Barcode Products 
 
PrecisionID offers a variety of barcode generation software.  Visit www.PrecisionID.com for more 
information on these products. 
 
Code 128 Barcode Fonts – Generate Code 128, UCC 128, EAN-128, and USS128 Barcodes easily 
using this package. 
 
Code 39 Barcode Fonts – Generate Code 39 (Code 3 of 9), LOGMARS, and HIBC Barcodes easily 
using this package. 
 
Interleaved 2 of 5 Barcode Fonts – Generate USS Interleaved 2 of 5, EAN-14, ITF-14, German Post 
Identcode and Leitcode Barcodes easily using this package. 
 
UPC Barcode Fonts - Generate UPC-A, UPC-E, UCC-12, EAN-8, EAN-13, ISBN, Bookland, and 
JAN barcodes using this package 
 
EAN Barcode Fonts - Generate EAN, EAN-13, EAN-8, UPC-A, UPC-E, UCC-12, ISBN, Bookland, 
and JAN barcodes using this package. 
 
POSTNET Barcode Fonts – Generate USPS POSTNET, Planet, and FIM barcodes using this package. 
 
Native ASP Barcode Generator – Generate most common barcodes on any website utilizing this 
ASP barcode generator. 
 
Barcode ActiveX Control – Generate most common barcodes in ActiveX graphics object compatible 
environments using this ActiveX control. 
 
Data Matrix Barcode ActiveX Control – Generate Data Matrix ECC200, PDF417, and Macro 
PDF417 barcodes in any ActiveX graphics objects compatible environment using this ActiveX control. 
 
PDF417 Barcode ActiveX Control – Generate PDF417, Macro PDF417, and Data Matrix ECC200 
barcodes in any ActiveX graphics objects compatible environment using this ActiveX control. 
 
OCR-A and OCR-B Fonts – Create bank checks, passports, credit card imprints, serial labels, postal 
mail, and more with this OCR-A and OCR-B font package. 
 
MICR E13B Fonts – Create bank checks and other paper based drafting documents using this MICR 
E13B Font Package. 


